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INTRODUCTION 

Thank you for your interest in SpeedMatters™ for Corporate Law, software designed to simplify the 
collection and management of corporate data and to automate the completion of all documents and 
forms required to incorporate, organize and maintain corporations incorporated in Ontario or federally 
in Canada.  

Although many government forms are available through various online sources, it is often annoying and 

time-consuming that you must re-enter information each time you complete a new document or form, 

even after you have entered that same information in another form or document for the same 

corporation. 

SpeedMatters™ for Corporate Law eliminates the need to enter information multiple times by 

collecting information once and then intelligently drafting all required documents and forms. 

SpeedMatters™ for Corporate Law was developed as a joint venture between Legal Systematics Canada 

Inc. and Lexcor Business Lawyers LLP. 

This is a demonstration version of SpeedMatters™ for Corporate Law which includes the full power of 
the system for data entry and analysis, however it only permits assembly of the following 4 documents: 

 Corporate Information Summary 

 Share Provisions (print version) 

 Register of Directors 

 Resolution for Confirmation of Shareholder Loans  

To generate any of the documents listed above, choose them from the Start Page and visit the Preview 
tab.  More detailed instructions are provided below.  If you select a document that is not available in this 
demonstration version, you will receive a notice to the effect that the desired document is not available. 

The demonstration version will expire on July 31, 2014 and you will no longer be able to use it, however 
your answer files will not be deleted from your computer and they will remain available for use should 
you purchase a license for SpeedMatters™ for Corporate Law. 

For more information, visit our SpeedMatters™ for Corporate Law website  
  

http://www.speedmatters.ca/SpeedMatters-for-Corporate-Law.aspx
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HOW TO INSTALL HOTDOCS 

SpeedMatters™ for Corporate Law uses the market-leading software, HotDocs®, as its document 

automation and generation engine.  One of our joint venture partners, Legal Systematics, Inc., is a 

Platinum Reseller of HotDocs® software. 

Before running SpeedMatters™ for Corporate Law, unless you already have HotDocs® 11 installed on 

your computer, you will need to install the free HotDocs® 11 Player.  See detailed instructions below. 

For your convenience, we have provided you with a link to the executable files required to install 

HotDocs® 11 Player v.11.05 (both 32 and 64 bit versions). 

1. To install the HotDocs® 11 Player, simply double click on the appropriate file (HotDocs Player 11 
32-bit or 64-bit) depending on whether you are running a 32 bit or 64 bit operating system.   

How to tell if you are running 32- or 64-bit operating system… 

Windows 8 - http://pcsupport.about.com/od/windows-8/a/windows-8-64-bit-32-bit.htm 

Windows 7- http://pcsupport.about.com/od/windows7/ht/windows-7-32-bit-64-bit.htm 

Windows Vista - http://pcsupport.about.com/od/windowsvista/ht/windows-vista-32-bit-64-bit.htm 

Windows XP - http://pcsupport.about.com/od/windowsxp/ht/windows-xp-32-bit-64-bit.htm  

2. Once you double click on the appropriate file, the HotDocs® setup screen will appear… 

 

http://www.hotdocs.com/downloads/player11
http://pcsupport.about.com/od/windows-8/a/windows-8-64-bit-32-bit.htm
http://pcsupport.about.com/od/windows7/ht/windows-7-32-bit-64-bit.htm
http://pcsupport.about.com/od/windowsvista/ht/windows-vista-32-bit-64-bit.htm
http://pcsupport.about.com/od/windowsxp/ht/windows-xp-32-bit-64-bit.htm
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3. Click “Next” to continue 

 

4. In order to continue with the installation, you will need to Accept the terms of the HotDocs® 11 
Player license agreement and click “Next”. 

5. You will then be prompted to select the Setup Type and the System Language.  Typical installation 
and English (Canada) are the default choices. 
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6. Next, select a supported Word Processor to use with HotDocs® and SpeedMatters™ for Corporate 
Law (from those installed on your computer)… 

 

7. The HotDocs® program will begin to Install … 
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8. Once complete, you can view the HotDocs® “ReadMe” file, Launch HotDocs® – or both. 

 

9. Click “Finish” and your HotDocs®  installation will be complete. 

10. For more information on HotDocs® or the HotDocs® 11 Player, please visit the HotDocs® website. 

RECOMMENDED HOTDOCS OPTIONS & SETTINGS 

 Once installed, we recommend that you minimize the number of changes you make to the default 

HotDocs® Options 

 Having said that, you may wish to turn off the warning for unanswered questions - otherwise 

HotDocs® will provide a warning about any unanswered variables every time you attempt to 

assemble a document, even if the answers to the unanswered questions are not necessary for the 

document you are assembling. 

 See Tools → Options and deselect “Display unanswered warning before saving documents” as 

illustrated below… 

 

http://www.hotdocs.com/press/hotdocs-maintains-strong-leadership-position-legal-market-document-generation
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HOW TO INSTALL SPEEDMATTERS FOR CORPORATE LAW 

Once the HotDocs® 11 Player has been installed, you are ready to install the demonstration version of 

SpeedMatters™ for Corporate Law  

1. Simply double-click on installation file provided.  It will have an .hdi (HotDocs Install) extension 
and will be named something like SMcorpdemo.hdi  

2. On your first use, the installer will suggest a default location for the installation of the 
SpeedMatters™ for Corporate Law template set.  To ensure proper operation of this demonstration 
version of the system, you should accept the default file locations.  

 

3. Click “OK” 

4. Before using the software for the first time, you must run the “System Settings” to accept the 
product’s license agreement and provide some basic information about your office.  You will not be 
required to revisit the System Settings after your first session. 

5. You can run System Settings in either of 2 ways - double-click “System Settings” from the Library 
shown in the tree-view on the left side of your display, or highlight “System Settings” and then click the 
“Assemble” button on the Command Bar. 
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6. Accept the terms of the SpeedMatters™ for Corporate Law license agreement.  In order to do so, 
click the box beside the words “I have read and accepted the License Agreement for SpeedMatters 
Corporate” and type your name in the blank provided. 

 

7. Click “Next” and you will be prompted to enter information about the licensed system user(s) of 
the SpeedMatters™ for Corporate Law Demo.  Complete all fields and click “Next”. 
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8. When the next screen appears, click “Finish”. 

 

9. Congratulations, your installation of SpeedMatters™ for Corporate Law is complete. You can now 
explore the system, enter information, and generate a corporate information summary and the 
documents included with the demonstration version.  

HOW TO USE THIS DEMONSTRATION VERSION 

Once you have installed the HotDocs® Player and you have accepted the license agreement and 

completed the System Settings, you are now ready to use the demonstration version of SpeedMatters™ 

for Corporate Law.  Enjoy. 

1. To use SpeedMatters™ for Corporate Law, the first step is to “Assemble” the “System”.  You can 
do this in 2 ways - either double-click the “System” from the Library in the left pane of your display, or 
alternatively, highlight “System” and then click the “Assemble” button on the Command Bar. 
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2. You will then be prompted to select an answer file.  You can create your own answer file, by 
selecting “New Answer File” in the prompt and clicking “OK”. 

 

3. Or, you can browse for an existing answer file by clicking the “open file folder” icon (highlighted 
above).  

 

4. Note that a sample answer file named “Conference Demo.anx” has been provided with this demo.  
The sample answer file includes pre-populated information for a relatively complex, but imaginary, 
corporation.  If desired, you can copy this file into your HotDocs/Answers directory, and then select it 
when you run the System.  Assembling the share provisions for this corporation will illustrate some of the 
power and scope of SpeedMatters™ for Corporate Law.  Of course, you are welcome to create and save 
as many of your own answer files as you wish, testing the system with as much complexity as you please. 

5. Once you have selected your desired answer file, click “OK” to open. 
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DEMONSTRATION DOCUMENTS 

1. Note that this is a Demonstration Version only – and although you will have the ability to navigate 
through all of the various interview screens and to input data into all fields – you will only be allowed to 
assemble or generate 4 specific documents – (i) a Corporate Information Summary, (ii) a Register of 
Directors, (iii) Minutes/Resolution to Confirm Shareholder Loans and (iv) Share Provisions – which is 
intended to give you a good understanding of the intelligence of SpeedMatters™ for Corporate Law.  

2. If you attempt to generate documents other than the 4 included, you will be greeted with a very 
annoying message to the effect that this is a demonstration version only and that the document(s) you 
are trying to generate are not available.  We would however be very happy to arrange for your purchase 
of the full system in all its glory.    

CORPORATE INFORMATION SUMMARY 

1. Once you have entered any corporate data relating to the corporation you are working on, or you 
have selected the sample answer file, you can view the Corporate Information Summary by navigating to 
the “Start Page”.  If you are on any other interview screen, click on “Start Page” at the top of the Interview 
Outline on the left side of your display. 
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2. From the Start Page, select “Produce Documents”, “Letters & Reports” and “Corporation 
Information Summary”.  

 

3. Once you have made the appropriate selections, click on the “Document Preview” tab to see a 
real-time preview of the document to be generated, in this case, the Corporate Information Summary. 
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4. To change any information in the Corporate Information Summary, go to the appropriate 
interview screen by selecting and clicking it from the Interview Outline at the left side of your display. 

 

5. Note that, at any time, even while you are busy generating other documents, you can view a quick 
summary of the corporate information contained in the current answer file by clicking on “Corporate 
Summary” from the Interview Outline. 
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6. If you wish to create a printable version of the Corporate Summary, simply click the button “Load 
printable summary in Document Preview tab”  

 

7. Then select the Document Preview tab. 

 

8. Note that the Document Preview window does not always accurately render what the final 
document will look like. 

9. Once satisfied with the information contained in the Document Preview, you can “Send Document 
to Word Processor” by clicking the button on the Command Bar. 

 

10. This will open the Corporate Information Summary in Microsoft Word or other word processor 
that you have chosen to use with the system. 
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DIRECTORS REGISTER 

1. To view the Register of Directors for the corporation in focus, navigate to the “Start Page” 

2. Select “Produce Documents”, “Registers and Ledgers” and “Register - Directors” 

 

3. Once you have made the appropriate selections, click the “Document Preview” tab to see a real-
time preview of the document to be generated. 
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4. To change any information in the Register of Directors, go to the Directors Interview by selecting 
and clicking it from the Interview Outline at the left side of your display. 

 

5. For example, to document the resignation of a director, select the director’s name from the 
Interview Outline and enter the date of resignation in the End/Cessation Date field. 

 

6. The Register of Directors will automatically update in real time… 

 

7. Although we have made every effort to make the preview identical to the word processor output, 
there are some circumstances where the Document Preview window does not render exactly what the 
final document generated by the word processor looks like. 

8. Once satisfied with the information contained in the Register of Directors, you can “Send 
Document to Word Processor” by clicking the button on the Command Bar 
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9. This will open the Register of Directors in Microsoft Word or other compatible word processor 
that you have chosen to use with the system. 

 

MINUTES/RESOLUTIONS – CONFIRM SHAREHOLDER LOANS 

1. To give you a sense of the power of the minutes and resolutions machinery, we have included one 
simple resolution, being a resolution Confirming Shareholder Loans 

2. To access the document, navigate to the “Start Page” 
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3. Select “Produce Documents”, “Minutes and Resolutions”, “One or more resolutions in a single 
document” and “Director written resolutions” 

 

4. Once you have made the appropriate selections, click the “Document Preview” tab to see a real-
time preview of the document to be generated – including properly merged names and references to a 
plural number of director. 
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5. Any necessary changes can be made from the various interviews on the Interview Outline.  For 
example, if one of the directors had resigned, you would navigate to the Directors interview and click the 
name of the director and enter the resignation date. 

 

6. After making the change, open the Document Preview and the document is updated in real time.  
See graphic below and notice how there is now only one signature line for the remaining director and that 
all references and grammar suitable for multiple directors have been updated to reflect that there is now 
only one sole director. 
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7. When running the full SMC system, you are able to select the Type and Method of decisions by 
expanding the Resolution Documents from the Interview Outline and selecting “Type and method”.  This 
feature has been disabled in the demonstration version. 

 

8. In order to change the Type and Method of passing resolutions in this demonstration version, you 
must make the Type and Method selections from the Start Page.  So, for example, if you want to have the 
same resolution passed by shareholders at a meeting, we would select this from the Start Page… 
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9. Then, you need to add some details about the meeting by selecting Meeting Details from the 
Interview Outline.  When did it happen?  Where did it occur?  Who was present?  Any others who attended 
by invitation?  Who acted as Chair? Secretary?  

 

10. Click on the Document Preview tab and instantly, you have minutes of a meeting of the voting 
shareholders. 
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11. If you wish to add a new director, but they do not appear in the drop down list, you must first add 
the new person in the People and Entities interview.  You can select the last person on the People and 
Entities list and then click “Add another person”.  Be careful that you do not accidentally start changing 
and overwrite the information of a person already entered.   

 

12. Once the information is entered the new person’s name will appear in the Interview Outline. 
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SHARE PROVISIONS 

1. To create Share Provisions, go to the “Start Page” 

2. Select “Produce Documents”, “Common Packages”, “Share Provisions” and “Paper”.  Note that 
the electronic version has been disabled for purposes of this demonstration version of the software. 

 

3. Expand the “Share Classes” interview from the Interview Outline to view the share classes in the 
current answer file. 
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4. Note the name of each share class appears, together with its rank for Dividends and Participation 
in the Interview Outline. 

 

5. To add a new class of shares, simply select the “Add another share class” button, which will open 
a new interview screen. 
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6. Simply answer the interview questions which will be used to intelligently draft the rights and 
privileges for your new class of shares … 

 

7. Once you have made the appropriate selections, click the “Document Preview” tab to see a real-
time preview of the share provisions.  Notice that the new class has been added... 
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8. The rankings have been updated… 

 

9. And, in addition to the rights and privileges for the pre-existing classes of shares, the rights and 
privileges of the new class have been drafted for you… 

 



– 26 – 
 

 

IMPORTANT CONCEPTS 

RESOURCES 

 Click on the “light bulb” icons  to access resources and tips relevant to the specific question or 

interview that you are working on 

REFERENCE DATE 

 Be aware of the Reference Date - it is an extremely important and valuable tool for getting the most 

out of Speedmatters Corporate. 

 

 The Reference Date allows you to display and produce documents pertaining to the Corporation as 

at any specific point in time. 

 Where temporal terms like "current" or "future" are used in any interview, they are relative to the 

Reference Date. 

 The Corporate Summary displays a summary of fundamental corporate information as at the 

Reference Date. 

 Although more current information about the Corporation may have been gathered, any documents 

produced will be produced based on the information contained in the Answer File as at the 

Reference Date. 
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 Unless you want to display information or produce documents with historical or future information, 

you should leave the Reference Date as the current date. 

STATUS 

 Set the “Status” of any data entered at the top right corner of each interview screen.   

 Any data which is intended to be reflected in a document to be generated should be marked as “To 

be documented”  

 

 Once data entry is complete and the information entered has been included in an assembled 

document, you should set the status to “Completed”.  This will cause each field in the active 

interview screen to be “greyed out”, which will help you avoid any accidental or unintentional 

overriding of your interview answers.  

 

 If you subsequently need to change any “greyed out” fields, simply change the status back to “To be 

documented” 

ANSWER FILES 

 Answer files are computer files created by SpeedMatters™ for Corporate Law which have an .anx 

extension.  These files contain all data pertaining to a given corporation which has been entered into 

SpeedMatters™ for Corporate Law through various interview screens. 

 The first step in working with any corporation, is to open a new answer file for that corporation. 

 

 New answer files can also be opened by clicking the “New Answers” button on the menu bar, by 

selecting the “New Answers” command from the File Menu (File → New Answers) or by selecting 

“Control+N” keys 
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 SAVE YOUR ANSWER FILES REGULARLY! 

 BACKUP YOUR ANSWER FILES REGULARLY! 

 You may also wish to take note of the last date your answer file was saved 

 

For purposes of the Demonstration Version of SpeedMatters™ for Corporate Law , we have included a 

sample answer file named “Conference Demo.anx”. 
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NAVIGATION 

 You may click “Next” or use the “PgDn” key on your computer to navigate through all of the various 

interviews in sequence or you may go directly to a specific interview by selecting it from the 

Interview Outline on the left side of your display. 
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If you are not able to see the Interview Outline on your display, ensure that it has been selected from 

the View menu (i.e. View → Interview Outline) 

 

SPECIFIC INTERVIEWS 

START PAGE 

REFERENCE DATE 

 Always check and ensure that the Reference Date is set to the desired date on the Start Page. 

 The Reference Date allows you to display and produce documents pertaining to the Corporation as 

at any specific point in time. 

 For a more detailed explanation, see Reference Date  

SHOW REMINDERS 

 If you wish to see reminders about the steps and documents pertaining to the Corporation which 

appear to outstanding, select “Yes”. 
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WHAT WOULD YOU LIKE TO DO TODAY? 

ENTER OR REVIEW INFORMATION 

 Enter or Review Information loads a Corporate Summary in the Document Preview window, 

providing an excellent overview of the Corporation’s most important corporate information as at 

the Reference Date, all of which is automatically generated from the information contained in the 

Corporation’s answer file 

 

 

 When working with a new Answer File, you will want to start by entering available information 

about the Corporation by selecting “Enter or Review Information” and then navigating through and 

completing each of the interviews 
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 You may click “Next” or use the “PgDn” key on your computer to navigate through all interviews in 

sequence or you may go directly to a specific interview by selecting it from the Interview Outline. 

 When entering data into a drop-down list, if the dropdown area appears white, then the user is able 

to add a new element by simply typing the desired text into the white area 

 When entering data, there are some things that YOU SHOULD NOT DO: 

o DO NOT delete a person who has already been assigned a role 

o DO NOT delete a share class as to which transactions have been recorded 

o DO NOT delete a share transaction that actually happened without making some offsetting 

starting balance entry 

 You can avoid accidental deletion or overwriting of your important data by changing the Status of 

the data to “Completed”, which will grey out the fields on the interview screen. 

PRODUCE DOCUMENTS 

 Once you have entered the necessary information, select “Produce Documents” from the Start Page 

to identify and load the documents you wish to generate into the Document Preview window 
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 You will be able to choose from Common Packages including Incorporation/Organization, Annuals 

and Share Provisions; or you may choose from a variety of individual documents and forms. 

 With the exception of PDF government forms, all documents whose “Status” is set to “To Be 

Documented” will be generated and included in the Document Preview tab 

 Documents may be produced at any time, however, unless information for each variable contained 

in the document you wish to create has been answered in the interviews, the missing information 

will not appear in the finished document.  

 You can click on the “Document Preview” tab at any time to see a real-time preview of the 

document you are producing.  If there are any unanswered questions, the missing variable name will 

appear like this *variable name*.  

 In many, but not all cases, you may click on the missing variable name to open the appropriate 

interview screen where you can provide the necessary answer. 
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CORPORATE SUMMARY 

 The Corporate Summary displays fundamental information about the Corporation which has been 

entered in Speedmatters as at the Reference Date, which defaults to the current date. 

 

 To view the Corporate Summary as at an earlier or later date, simply select the desired date from 

the Reference Date calendar and the Corporate Summary will immediately update. 

 

 To create a printable version of the Corporate Summary, simply click the button “Load printable 

summary in Document Preview tab” and then select the Document Preview tab. 
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ADMINISTRATIVE INFORMATION 

The Administrative Information interview is where you are able to record and track your internal client 

and matter information and other general information about the Corporation. 

The Responsible Person, Alternate Person, Contact Person and All Data Verified By dropdown lists are 

prepopulated with information gathered from the User’s System Settings. 

GLOBAL DATE FOR DOCUMENTS 

If entered, the Global Date for Documents is the date that will be applied to all documents currently being 

produced. 

 You can leave the Global Date for Documents blank, which will result in a blank line for all dates like 

this: 

 

DATED this            day of                                              , 20          . 

 

 You can select a specific date for all documents, which will result in a date line such as this: 

DATED this 1st day of January, 2015. 

 You may select a one or more of the components - specific day, specific month or specific year, 

which will yield results such as these: 

DATED this            day of January, 2015. 

DATED this            day of                                            , 2015. 



– 36 – 
 

 

CHARTER INSTRUMENTS 

The Information provided in this interview will be used to populate the Articles you are preparing and 

any reports in respect of the Corporation after the charter instrument is filed. 

CHARTER TYPE, EFFECTIVE DATE & STATUS 

 Select the type of Charter document you wish to record and/or produce. 

 If you are providing information about the Corporation’s first Charter Instrument, the Charter 

Instrument type must be Articles of Incorporation, Amalgamation or Continuance. 

 For subsequent Charter Instruments, additional Charter types are available including: 

Amendment, Dissolution, Revival, Arrangement, Reorganization, Application for Authorization 

to Continue in Another Jurisdiction and Restated Articles of Incorporation. 

 Once the Charter Instrument has been filed, you will include the “Effective Date” of the Charter 

and select the “Status” of “Completed”.  This date will be used for reporting to the client and the 

Corporate Summary. 

 If you are entering information about a Charter Instrument yet to be produced, then you may 

enter an “Effective Date” or leave it blank to get a blank date line – however, you must select 

the “Status” of “To Be Documented” in order for the Charter Instrument to be generated in the 

Document Preview tab. 

ENTITY TYPE 

 Select the Corporation’s entity type. 

 The default type is “Private Issuer” which means that there are restrictions on the transfer of 

shares which will exempt the Corporation from the prospectus requirements of the Securities 

Act. 

NAME OF CORPORATION 

 Enter the Corporation’s name and the type of name. 

 If the name of the Corporation is a number name, you will be prompted to enter the “Legal 

Ending”. 

 If the name of the Corporation is other than a number name, you will be prompted for the 

information related to the NUANS search  required to file the Articles. 

NUMBER OF DIRECTORS 

 Determine if the Corporation will have a fixed number of directors or a minimum and maximum 

number of directors.  The latter provides for more flexibility in the composition of the board. 

 If the Corporation has or will have a fixed Number of Directors, enter the number. 



– 37 – 
 

 

 If the Corporation has or will have a minimum and maximum number, enter a number for each 

the minimum and the maximum. 

RESTRICTIONS ON THE BUSINESS THE CORPORATION MAY CARRY ON 

 Determine if the business of the Corporation is to be restricted.   

 To provide maximum flexibility as to the type of business the Corporation may carry on, select 

“None”. 

 To include restrictions, click “Other” and enter the restrictions in the space provided. 

RESTRICTIONS ON THE ISSUE, TRANSFER AND OWNERSHIP OF SHARES 

 In order to qualify as a Private Issuer, the transfer of shares in the capital of the Corporation 

must be restricted.   

 Determine whether the Corporation will have transfer restrictions.  If so, select whether the 

restriction requires director, shareholder of director or shareholder consent.  To see the result 

of the different choices, look at the Charter Instrument in the Document Preview tab. 

 To include other restrictions, click “Other” and enter the restrictions in the space provided. 

OTHER PROVISIONS 

 Select any of the identified provisions or “None of the Above”. 

 To include custom provisions, click “Other” and enter the other provisions in the space 

provided. 

NOTES  

 The user may enter notes and reminders about the Corporation here, including the date on 

which the Charter Instrument was delivered to the client. 

CORPORATE ADDRESSES 

 Enter the Corporation’s address information in this interview. 

 Include start and end dates to ensure that all reporting is accurate as at any given point in time. 

 The Registered Office address is required for originating charter instruments such as Articles of 

Incorporation, Amalgamation and Continuance as well as government reporting forms, such as a 

Form 1 – Initial Return or Notice of Change. 

 Mailing address is used for correspondence. 

 Location of Corporate Records is gathered for inclusion in reports to clients. 

 Extra-jurisdictional office addresses reflect the Corporation’s registered office addresses in 

jurisdictions other than its originating jurisdiction for reporting purposes. 
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SHARE CLASSES 

 Enter all information regarding the classes of shares the Corporation is authorized to issue in 

this interview, together with their respective rights, privileges, conditions and restrictions, which 

will be used to intelligently draft charter instruments (Articles of Incorporation, Amalgamation, 

Amendment, etc.) and for reporting purposes. 

 The Interview Outline on the left side of the display shows the classes of shares that have been 

entered into Speedmatters, together with the rank of each class for purposes of dividends and 

participation in parentheses.   

 As an example: Class A Preference (1|1) means that the Corporation is authorized to issue Class 

A Preference shares which rank 1st for dividends and 1st for participation upon dissolution, 

winding up, etc. 

 Because all Corporations require shares with the right to vote and to participate on dissolution 

or winding up, by default Speedmatters includes the rights and privileges customarily associated 

with Common shares which include the right to vote (1 vote per share), the right to receive 

dividends at the discretion of the directors and the right to participate in the distribution of the 

Corporation’s assets on dissolution or winding up . 

SEPARATE CLASS VOTE FOR 

By selecting one or more of the check boxes, a provision will be included in the rights and privileges of 

the share class which is designed to distinguish this class of shares from another class having 

substantially the same attributes.  The intention is to eliminate any potential argument to the effect that 

two or more share classes are identical and therefore, they are one and the same class for purposes of 

paying dividends or participating in winding up, etc. 

CHANGE OF NAME 

The holders of [Class Name] shares shall be entitled to vote separately as a class in respect of any 

proposal to change the name of the Corporation. 

NUMBER OF DIRECTORS 

The holders of [Class Name] shares shall be entitled vote separately as a class in respect of any proposal 

to change the number, or the minimum and maximum number, of directors of the Corporation. 

REGISTERED OFFICE 

The holders of [Class Name] shares shall be entitled vote separately as a class in respect of any proposal 

to change the municipality or geographic township in which the Corporation's registered office is 

located. 
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PURCHASE RIGHTS 

By selecting this check box, the following provision will be included in the rights and privileges of the 

share class … 

Subject to the provisions of applicable law, in addition to the right of redemption hereinbefore 

provided to the Corporation, the Corporation shall have the right to purchase at any time the 

whole or from time to time any part of the [Class Name] shares then outstanding pursuant to 

tenders or, with the unanimous consent of the holders of all the [Class Name] shares then 

outstanding, by private contract at prices not exceeding an amount equal to the Redemption 

Amount thereof and costs of purchase.  If, in response to an invitation for tenders, two or more 

holders of [Class Name] shares submit tenders at the same price and if such tenders are 

acceptable to the Corporation, then unless the Corporation accepts all such tenders in whole, 

the Corporation shall accept such tenders in proportion as nearly as may be to the number of 

[Class Name] shares offered in each such tender. 

PRE-EMPTIVE RIGHTS 

By selecting this check box, the following provisions will be included in the rights and privileges of the 
share class which is intended to provide existing shareholders with a right to purchase a pro rata share 
of any new shares to be issued to avoid dilution of their interests … 

No [Class Name] shares in the capital of the Corporation shall be issued unless such shares (the 
"Offered Shares") have first been offered pro rata to the holders ("Offerees") of [Class Name] 
shares (the "Base Shares") in accordance with the procedure hereinafter set forth. 

Pre-Emptive Rights Procedure 

The following procedure shall apply to each class of shares in respect of which a pre-emptive 

right is provided above and all terms defined in respect of such class shall have the same 

meaning herein for purposes of such class: 

    (a)    Issuance Notice.  The Corporation shall provide written notice (the "Issuance Notice") to 
each of the Offerees setting out the terms and conditions upon which the Offered Shares are 
being offered, including the subscription price and how the proceeds of the issue are intended to 
be used. 
 
    (b)    Right to Purchase.  Upon the Issuance Notice being given, the Offerees shall have the right 
to purchase the Offered Shares at the price specified, pro rata according to the number of Base 
Shares held by such Offerees or in such other proportion as the Offerees may unanimously agree. 
 
    (c)    Notice of Acceptance.  Within 10 days of receiving the Issuance Notice, the Offerees shall 
give notice to the Corporation stating whether or not they wish to purchase any or all of the 
Offered Shares.  If any Offeree does not give such notice or gives notice that it is not willing to 
purchase all of the Offered Shares to which he, she or it is entitled, the Offered Shares that such 
Offeree had been entitled to purchase or the part thereof that the Offeree is not willing to 
purchase (the "Rejected Shares") may instead be purchased by the other Offerees who gave 
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notice that they were willing to purchase all of the Offered Shares to which they were entitled, 
pro rata based upon the number of Base Shares held by such other Offerees or in such other 
proportion as such other Offerees may unanimously agree.  Within 10 days of the expiry of the 
first 10 day period specified above, each other Offeree who desires to purchase any or all of the 
Rejected Shares that such other Offeree is entitled to purchase in accordance with the provisions 
hereof shall give an additional notice to the Offeror and to the Corporation.  If any other Offeree 
entitled to give the said additional notice does not do so or gives notice that he, she or it is not 
willing to purchase all of the Rejected Shares to which he, she or it is entitled, the Rejected Shares 
that such Offeree had been entitled to purchase or the part thereof that such Offeree is not willing 
to purchase may instead be purchased by the other Offerees who gave the said additional notice 
that they were willing to purchase all of the Rejected Shares to which they were entitled, and so 
on from time to time until the other Offerees are willing to purchase all of the Offered Shares or 
until they are not willing to purchase any more. 
 
    (d)    Deposit.  Where an Offeree gives a notice pursuant to the previous paragraph, that he, she 
or it is willing to purchase any of the Offered Shares (the "Accepted Shares"), such notice shall not 
be valid unless it is accompanied by a deposit equal to 100% of the subscription price for the 
Accepted Shares, by certified cheque or bank draft payable to the Corporation's solicitors, in trust.  
If the purchase of the Accepted Shares is not completed as provided herein: 
 
        (i)    for any reason other than the default of such Offeree, the full amount of the deposit shall 
be returned to such Offeree, without interest or deduction; or 
 
        (ii)    as a result of the default of such Offeree, the deposit shall be forfeit to the Corporation 
as liquidated damages (not as a penalty) without limiting any other rights of the Corporation or 
any other person. 
 
    (e)    Completion.  If the Offerees are willing to purchase any of the Offered Shares, the purchase 
and sale thereof shall be completed on the 10th day following expiry of the last of the applicable 
time periods specified above, or, if such day is not a business day, the next ensuing business day, 
at the Corporation's registered office. 
 
    (f)    Offer to Third Parties.  In the event that there remain any Rejected Shares after expiry of 
the last of the applicable time periods specified above, the Corporation may, at any time within 
the ensuing 90 days, offer such Rejected Shares pursuant to the terms of the Issuance Notice to 
any person who is not an Offeree. 

Fractional Shares.  If any Offered Shares shall not be capable, without division into fractions, of 

being offered to or being divided among the Offerees in the proportion above-mentioned, the 

same shall be offered to or divided among the Offerees as nearly as may be in these proportions 

and any balance shall be offered to or divided among the Offerees or some of them in such 

manner as may be determined by the directors of the Corporation. 
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LEGEND FOR SHARE CERTIFICATES 

 

Insert the text of any notice or legend which you wish to be included in the Corporation’s share 
certificates or notices re: issuance or transfer of uncertificated securities.  For example, you may wish 
to include a notice to the effect that the transfer of shares is restricted by the terms of a unanimous 
shareholder agreement, etc. 

PROTECTION OF ASSETS REQUIRED FOR REDEMPTION 

 

By selecting this check box, the following provisions will be included in the rights and privileges of the 
share class which is intended to protect the redemption value of the class by prohibiting dividends on 
junior classes of shares if doing so would result in the Corporation’s inability to redeem all of the shares 
of the class. 

In no event shall: 

    (a)    any dividend be declared or paid on; 
 
    (b)    any distribution or reduction of capital be made to the holders of; or 
 
    (c)    the Corporation redeem or purchase for cancellation or otherwise; 
 

any share or shares of the Corporation, if any, ranking junior to the [Class Name] shares if, in the 

opinion of the directors of the Corporation, the amount by which the realizable value of the 

assets of the Corporation exceeds its liabilities at such time is or would become, as a result of 

the payment of such dividend or the making of such distribution, reduction of capital, 

redemption or purchase, as the case may be, less than the amount required to redeem all of the 

then issued and outstanding [Class Name] shares at the Redemption Amount per share 

hereinbefore provided. 

CONVERTIBLE 

 
By selecting this check box, the following provisions will be included in the rights and privileges of the 
share class which is intended to allow the holders of this class of shares to convert them into one or 
more shares of another class. 

Conversion Privilege 

Each issued and outstanding [1st Class Name] share (the "Convertible Shares") may be 

converted, at the option of the holder, into 1 issued and outstanding [2nd Class Name] shares 
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(the "Converted Shares") of the Corporation by giving notice (the "Conversion Notice") in writing 

to the Corporation at any time in accordance with the procedure hereinafter set forth. 

Conversion Procedure 
 
The following procedure shall apply to each class of shares in respect of which a conversion right 
is provided above and all terms defined in respect of such class shall have the same meaning 
herein for purposes of such class.  The Conversion Notice shall be accompanied by one or more 
certificates representing the Convertible Shares in respect of which the holder thereof desires to 
exercise such right of conversion and such notice shall be signed by the holder of the 
Convertible Shares in respect of which such right is being exercised and shall specify the number 
of Convertible Shares which the holder desires to have converted.  The holder shall also pay any 
governmental or other tax imposed in respect of such transaction.  Upon receipt of the 
Conversion Notice, the Corporation shall issue a certificate representing the required number of 
fully paid Converted Shares upon the basis above prescribed and in accordance with the 
provisions hereof to the holder of the Convertible Shares represented by the certificate or 
certificates accompanying such notice, provided that the Corporation may disregard any fraction 
of a Converted Share which arises from such conversion.  If less than all of the Convertible 
Shares represented by any certificate are to be converted, the holder shall be entitled to receive 
a new certificate for the Convertible Shares representing the shares comprised in the original 
certificate which are not to be converted.  All shares resulting from any conversion of fully paid 
Convertible Shares into Converted Shares pursuant to this provision shall be deemed to be fully 
paid and non-assessable. 

 

PEOPLE AND ENTITIES 

 Before any person or entity will be available for selection as an accountant or auditor, bank, 

director, incorporator, officer, shareholder or solicitor of the Corporation, the name of the 

person or entity must be entered in the People and Entities interview. 

 You should also enter the address and other information pertinent to the person or entity in this 

interview for use in document preparation and reporting purposes. 

 Note that for individuals, the person’s proper legal names will go in the First Name, Middle 

Name and Last Name fields. 

 By selecting the box “Edit name to be used in documents”, you will have the opportunity to edit 

the way the person’s name will appear in all documents, other than government forms.  For 

example, if a person’s legal name is “Jonathan Francis Doe”, you may indicate that the “Name to 

be used in documents” is “John Doe”, in which case the person’s name will be shown as “John 

Doe” in all documents and signature lines other than in government forms. 

ACCOUNTANTS AND AUDITORS 

 Select the Accountant or Auditor from the dropdown list. 

 If the name of the desired Accountant or Auditor does not appear in the dropdown list, you 

must first go to the People and Entities interview (by selecting it from the Interview Outline on 

the left side of your display), enter the name and any other pertinent information about the 
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Accountant or Auditor and then return to the Accountants and Auditors interview (by selecting 

it from the Interview  Outline) and then complete your selection. 

 Indicate whether the selected entity is acting as accountant or auditor for the Corporation 

 To allow for accurate reporting at any point in time, enter the Start/Effective Date and, if 

appropriate, the End/Cessation  Date. 

 Note that if there is no auditor, all shareholders are required to consent to audit exemption 

each financial year. 

BANKS 

 Select the Corporation’s Bank from the dropdown list. 

 If the name of the desired Bank does not appear in the dropdown list, you must first go to the 

People and Entities interview (by selecting it from the Interview Outline on the left side of your 

display), enter the name and any other pertinent information about the Bank and then return to 

the Banks interview (by selecting it from the Interview  Outline) and then complete your 

selection. 

 Note that if the “Type of Person” is “Individual” in the “People and Entities” interview, that 

person will not be available for selection as a Bank.  If you wish to show an individual as a Bank, 

go to the People and Entities interview and change the “Type of Person” to “Sole Proprietor” or 

other appropriate person type. 

 To allow for accurate reporting at any point in time, enter the Start/Effective Date and, if 

appropriate, the End/Cessation  Date. 

DIRECTORS 

 Select a Director from the dropdown list. 

 If the name of the desired Director does not appear in the dropdown list, you must first go to 

the People and Entities interview (by selecting it from the Interview Outline on the left side of 

your display), enter the name and any other pertinent information about the Director and then 

return to the Directors interview (by selecting it from the Interview  Outline) and then complete 

your selection. 

 Note that only “Individuals” will be available for selection as Directors.  If a person’s name is 

entered in the “People and Entities interview, you should ensure that the “Type of Person” is 

“Individual” in the dropdown list. 

 To allow for accurate reporting at any point in time, enter the Start/Effective Date and, if 

appropriate, the End/Cessation  Date. 

MANAGING REPEATS 

Be aware that you can’t sort or filter repeat dialogs in an interview, but you can reorder them, if the 

order in which they were entered is not satisfactory.  Right click.  (Note – there is possible danger of at 

least temporary indexing confusion in the HotDocs session if the item is referenced elsewhere by its 

index rather than by a permanent ID.) 
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Note that you can copy iterations of a repeat, e.g. a share class.  Handy if you need to create one that is 

largely similar to an existing one.  Right click on the target iteration. 

MANAGING ANSWER FILES 

Back up your answer files! 

Click the answer file save button every so often during a session so that your latest information is 

stored, and not lost if your system crashes or other problems prevent normal exit and saving. 

Note that while you can Undo (and Redo) edits in text fields, most other operations in an interview are 

not undoable. 

If you make a big mistake in a session, like deleting critical information, the best approach is to exit 

without saving, so as to be able to return to the earlier answer file version. 

OVERLAYING ANSWER FILES 

A great way to save time is to re-use and recycle some of your most common answers. Speedmatters for 

Corporate Law makes this easy by enabling you to overlay one a set of answers over the answer file for 

the corporation you are working on.  In this Demo Version, you should only overlay answer files on 

new or blank answer files or it will overwrite the information that is already in the existing answer fie.  

In the full system, there will be specific interviews for collecting overlay information and you will not 

have to worry about overwriting other information.  The general overlay process is described below. 

1. First, create an answer file to hold the common information that you wish to re-use.  Double click 
“System” from the Interview Outline to assemble it.  This will bring up the prompt for which answer file 
you would like to use.  Click “OK” to create a new answer file. 

 

2. For this example, we will create 2 share classes which we intend to use regularly – plain vanilla 
common shares and some ridiculously complex special shares.  To do this, open the “Share Classes” 
interview from the Interview Outline. 
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3. Notice that in a new answer file, all of the most common rights and privileges for regular common 
shares are prepopulated.  Voting, one vote per share, discretionary dividends, participating rateably, non-
redeemable, non-retractable and non-convertible, with no other special rights. So, for this class of shares, 
one click and we’re done.  For this example, we will give the class a more catchy name. 
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4. Click “Add another share class” at the bottom of the interview screen… 

 

5. Answer the interview questions to determine the rights and privileges… 
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6. Open the “Document Preview” tab to check out your handiwork… 
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7. Save your answer file – click the “Save Answers” button on the Command Bar, give it a great name 
and click “OK”. 
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8. Close the answer file – either click the X in the top right corner, or select File → Close. 

 

9. Open the answer file for the corporation you would like to work on. 

 

10. Expand the “Share Classes” interview 
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11. From the File menu, select “Overlay Answers” and then select the answer file which contains the 
data that you wish to re-use – in this case “Favourite Share Classes”. 

 

12. Double-click and the Favourite Share Classes instantly replace the share classes which previously 
existed. 
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